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This is the tutorial for IBM Debug Tool for z/OS®, one of the IBM zSeries® problem 
determination tools. 
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Using Debug Tool's graphical user interface 

� Starting the debugger 

� Debug perspective views and navigation 

� Using the debugger 
� Stepping through statements and running the program 

� Program statement breakpoints 
� Monitoring variables 

� Making breakpoints conditional 
� Watch breakpoints 
� Program entry and exit breakpoints 

� Ending the debugging session 

� Loading program debug files 
� Loading sysdebug, listings, dwarf, and source files 

� Loading LANGX files 

Debug Tool tutorial 
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This section introduces you to Debug Tool's graphical user interface. You will see an 
overview of starting the debugger, learn about the windows shown in the interface, and 
how to navigate them. 
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The Debug Tool GUI can run on CICS Explorer 
or Rational Developer for System z 

� CICS Explorer® is an Eclipse platform, where the IBM problem 
determination tools plug-ins can run (including Debug Tool) 
�	 With the PD Tools plug-ins, CICS Explorer is not only for CICS 

applications 

� CICS Explorer and the PD Tools plug-ins are free to download and run 

� Rational® Developer for System z® is an Eclipse-based Integrated 
Development Environment (IDE) 
�	 Interactive access to z/OS for application development, job generation, 

submission, monitoring, debugging, command execution, and more 

� The Debug Tool plug-in is included 

IBM Debug Tool for z/OS tutorial 3 © 2012 IBM Corporation 

The Debug Tool plug-in for eclipse enables debugging of C, C++, COBOL, PL/I, and 
assembler programs. The program being debugged runs on the host z/OS system, but the 
debugger is displayed on your workstation. 

The GUI debugger is an eclipse plug-in, so it needs an eclipse platform to run. Eclipse is 
a popular integrated development environment standard, and there are several eclipse 
platforms available. CICS Explorer is an eclipse platform where the Debug Tool plug-in 
can run. It is a good choice as the eclipse platform, since it can be downloaded from the 
IBM web site and used at no charge, and is maintained and supported. By the way, do not 
let the name fool you. It is not just for CICS applications. With the plug-in you can debug 
any program supported by Debug Tool, including batch, CICS, IMS™, DB2®, and others. 

Rational Developer for System z is a complete integrated development environment, 
providing advanced features for z/OS developers. The debug tool plug-in in included. 
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Download CICS Explorer and the plug-ins 
from the IBM web site 

Download CICS Explorer at www.ibm.com/software/htp/cics/explorer 

Then download the PD Tools plug-ins at 
www.ibm.com/software/awdtools/deployment/pdtplugin 
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CICS Explorer can be downloaded at no charge from the IBM web site. Go to 
www.ibm.com/software/htp/cics/explorer, click the download button, and follow the 
instructions to install it. Then download and install the IBM PD Tools plug-ins, including 
the Debug Tool plug-in, at www.ibm.com/software/awdtools/deployment/pdtplugins. 
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IBM Debug Tool for z/OS tutorial 5 p 

Definition of terms 
for the Debug Tool GUI 

� Workbench 
� The desktop 

environmen 

� Perspective 
� A set of 

functions an 
capabilities 

� The Debug 
Tool GUI is 
perspective 

� View 
� A window 

within a 
perspective 
providing a 
specific 
capability 

Here are a few eclipse terms you will be hearing in this tutorial. First, the workbench is 
what you see when you start the eclipse platform. It consists of perspectives. 

A perspective provides a set of functions and capabilities. The debugging plug-in is an 
example of a perspective. It contains one or more views. 

A view is a window in a perspective that provides a particular capability, such as an 
editor or status window. 

DTv12s17GUIIntroductionAndViews.ppt Page 5 of 40 



  

       

     

  

     

  
       

  
 

  
 

     

    

    
       

   

  

          

Using Debug Tool's graphical user interface 

� Starting the debugger 

� Debug perspective views and navigation 

� Using the debugger 
� Stepping through statements and running the program 

� Program statement breakpoints 
� Monitoring variables 

� Making breakpoints conditional 
� Watch breakpoints 
� Program entry and exit breakpoints 

� Ending the debugging session 

� Loading program debug files 
� Loading sysdebug, listings, dwarf, and source files 

� Loading LANGX files 

Debug Tool tutorial 
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Next, you will see an overview of starting the GUI debugger. 
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Starting the remote graphical user interface 

y 
Start GUI debugging software 
on your workstation 

p 
You must have an eclipse platform, such 
as CICS Explorer installed 

dbl 
click 

First, an eclipse platform such as CICS Explorer with the Debug Tool plug-in must be 
installed on your work station. Double click the icon to start it. 
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This welcome window is displayed the 
first time you start CICS Explorer 

      
      

Click the  X to close 
the welcome window

     
  

Overview, tutorials, and first steps    

               
               

                 
       

CICS Explorer welcome panel 

This welcome window is displayed the 
first time you start CICS Explorer 

Click the X to close 
the welcome window 

click 

Overview, tutorials, and first steps 

8 IBM Debug Tool for z/OS tutorial © 2012 IBM Corporation 

The first time you start CICS Explorer, the workbench opens and the welcome view is 
displayed. There are icons for items such as the overview, tutorials, and the "first steps" 
guide. Close the welcome view by clicking the “x” on its tab. You can re-open it later if 
needed by clicking Help > Welcome from the menu. 

DTv12s17GUIIntroductionAndViews.ppt Page 8 of 40 



  

       

   

The default CICS SM perspective is 
shown. Click this button in the upper right 
corner to change perspectives 

      
        

    

Perspective:
• Contains views and editors
• Controls the menus and tool bars

   
     

             
              

          

Default CICS Explorer perspective 

The default CICS SM perspective is 
shown. Click this button in the upper right 
corner to change perspectives 

Perspective: 
• Contains views and editors 
• Controls the menus and tool bars 

click 
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In CICS Explorer, the default perspective is CICS SM. A perspective contains associated 
views and editors. Switch to the Debug Tool perspective. There are several ways to 
change perspectives. In this example the “Open Perspective” button is clicked. 

DTv12s17GUIIntroductionAndViews.ppt Page 9 of 40 



  

       

    

2
1

3

Select the “Debug”
ers ective and click “Ok”

  
   

            
           

Switching to the Debug perspective 

click 

2 
1click 

click 

3 

p p 
Select the “Debug” 
perspective and click “Ok” 
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After clicking the “Open Perspective” button, click “Other…”. A pop-up window lists the 
available perspectives. Select “Debug” to open the Debug perspective, and click OK. 
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The Debug perspective 

p p e 
Notice the selected 
perspective is indicated here 
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The Debug perspective is opened. 

DTv12s17GUIIntroductionAndViews.ppt Page 11 of 40 



  

       

        
      

 Listening 

 Not Listening  It must be in "listenin " mode     

Click the down arrow next 
to the connection icon
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To get the workstation TCP/IP address, click the 
down arrow next to the connection icon 

== Listening 

== Not Listening 

click 

gIt must be in "listening" mode 

Click the down arrow next 
to the connection icon 

The debugger must be in “listening” mode. There is an icon on the toolbar that shows the 
listening status. If it is not listening, the listener icon is red, and you can click the icon to 
switch it on. The icon is green when the listener is on. 

You need to determine your workstation's IP address. Click the small black down arrow 
next to the listening icon. 
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Note the port number, and click Get Workstation IP… 

click 

Click "Get Workstation IP" 

( p ) 

This is the listener’s TCP/IP port number 
(8001 in this example) 

That displays a menu. Make a note of the listener’s IP port. In this example, it is 8001. 
Then, click “Get Workstation IP”. 
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Note the TCP/IP address of your workstation 

This is the TCP/IP address of the workstation. 
You will need this address and the port 
number to start the debugger. 

click 

click 

Make a note of your workstation’s IP address. At this point, the GUI debugger is ready to 
receive a debugging session. Click OK to close the pop-up window. Next, a terminal 
session is displayed. 
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Batch example: set a debugging trigger, 
and submit the JCL to run the batch job 

jSubmit the job 

Enter Specify the TCP/IP address and port 
in the LE TEST option to trigger the 
debugger when the step runs 

In this example, a batch program will be debugged. In TSO, which is accessed in it's own 
terminal session, edit the JCL used to run the program. One easy way to debug a batch 
program is to code a CEEOPTS DD statement. In the CEEOPTS DD, a TEST option is 
coded. Specify your workstation's TCP address and port number in the TEST option. The 
JCL is submitted to batch. 

View other sections of the tutorial to learn how to start a remote debugging session. 
There are different tutorial sections that describe starting the debugger for programs 
running in various environments such as batch, CICS, and others. 
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When the step runs, the TEST option is processed, 
and the debu er is dis la ed
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When the job step runs, the debugger is triggered 

click 

Select the GUI 

gg p y 
When the step runs, the TEST option is processed, 
and the debugger is displayed 

When the job step with the TEST option runs, the debugger starts and is displayed by the 
GUI debugging software. Select the debugger window. 
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Note: variable values will not display unti  
the ro ram has initialized

       
   

At this point you can:
•Set breakpoints
•Monitor variables
•Run the program

    
 

 
  

The ro ram has not started et     

STEP or Resume will enter the 
program

      

                
              

             
                 

      

Active debugging session 

l 
p g 

Note: variable values will not display until 
the program has initialized 

At this point you can: 
•Set breakpoints 
•Monitor variables 
•Run the program 

p g yThe program has not started yet 

STEP or Resume will enter the 
program 
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This is an example of a session that just started. Most applications are paused before the 
initialization of the main program. The main program has not yet started. Be aware that 
variables do not exist until the program initializes, which happens automatically when you 
run or step into the program. At this point, you can set breakpoints, add variables to the 
monitor, change settings, and run the program. 
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Using Debug Tool's graphical user interface 

� Starting the debugger 

� Debug perspective views and navigation 

� Using the debugger 
� Stepping through statements and running the program 

� Program statement breakpoints 
� Monitoring variables 

� Making breakpoints conditional 
� Watch breakpoints 
� Program entry and exit breakpoints 

� Ending the debugging session 

� Loading program debug files 
� Loading sysdebug, listings, dwarf, and source files 

� Loading LANGX files 

Debug Tool tutorial 
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Next you will learn about the various views shown in the debug perspective. 
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Debu  console 

Debu  view Monitors, 
breakpoints, 
listings… views

 
 

Source view 

               
       

Debug perspective 

gDebug console 

gDebug view 

Source view 

Monitors, 
breakpoints, 
listings… views 
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Notice that the debug perspective has several panes. Each pane can have one or more 
“views” in it, and each view has a tab. 
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You can display a view 
by clicking on it's tab

     
    

Views
• Support editors and provide ways to navigate 
your Workbench
• Can appear by itself, or stacked with other     
views in a tabbed notebook

       
 
            
    

             
                

       

Display a view 

You can display a view 
by clicking on it's tab 

click 

Views 
• Support editors and provide ways to navigate 
your Workbench 
• Can appear by itself, or stacked with other 
views in a tabbed notebook 
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The pane in the upper right contains five views: variables, breakpoints, registers, monitors, 
and modules. Select a view by clicking it’s tab. Here, the breakpoints view is in the 
forefront, and the registers tab is clicked. 
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Result of clicking a view’s tab 
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That brought the registers view to the front. 
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You can expand a view by 
double clicking on it's tab

      
   

You can resize panes 
by dragging the borders

    
   

                  
            

Resizing views 

dbl 
click 

-

You can expand a view by 
double-clicking on it's tab 

You can resize panes 
by dragging the borders 
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It is easy to change the size of a pane, just drag-and-drop it's borders. You can expand a 
view by double-clicking it’s tab. The tab of the source view is double-clicked. 
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You can reduce an expanded 
view by double clicking it's tab

     
    

                 
               

dbl 
click 

Full screen view window 

-

You can reduce an expanded 
view by double-clicking it's tab 
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That expanded it to fill the entire workbench. Sometimes it is helpful to expand a view so 
you can see more information. Reduce it to it’s original size by double-clicking it’s tab 
again. 
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You can move a view 
to another pane by 
dragging its tab

     
    

  

                 
   

Drag a view to another pane 

You can move a view 
to another pane by 
dragging its tab 

drag 
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You can move a view by dragging and dropping it's tab into a different pane. Here, the 
monitors view is moved. 
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Relocated tab 
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Now the monitors view is located in the same pane as the debug view. This lets you 
control which views are visible at the same time. 
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You can reset the windows to 
their default position with     
Window > Reset Perspective

      
        

  

                 
               

Restore the default view configuration 

-

You can reset the windows to 
their default position with 
Window -> Reset Perspective 

click 
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Do not be too concerned about moving, resizing, or closing views. It is easy to get them 
back to their original places. To reset the views click the “window” menu, and select “reset 
perspective”. 
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Reset perspective result 

click 
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Then click “Ok" in the “reset perspective” pop-up. 
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Reset perspective result 
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The debug perspective was reset, with the default views shown and put back in their 
original positions. 
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The Source view 

Source view description 
� Displays program source 

� The next statement that will run is highlighted 

� Set and remove statement breakpoints 

� Right clicking reveals view specific actions 

IBM Debug Tool for z/OS tutorial 29 © 2012 IBM Corporation 

The source view displays the program. Notice that one of the statements is highlighted. 
That is the current statement, which is the next statement that will run. The grey area to 
the left of the program statements can be used to set or remove statement breakpoints. 
Right clicking in the source view displays an action menu, which can be used to add 
breakpoints, jump or run to a statement, and take other actions. 
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The Debug view shows 
currently running programs

    
  

            

The Debug view 

Debug view description 
� Controls running and terminating the program 

� Step controls to step through the program line by line 

� Retrieve the workstation IP address 

The Debug view shows 
currently running programs 

30 IBM Debug Tool for z/OS tutorial © 2012 IBM Corporation 

The debug view displays the current call chain, or program stack. 
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Step Return: 
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debug engine
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Debug view action bar buttons 

Resume: Run 
the program to 
the next 
breakpoint or 
to the end 

Terminate: 
End the 
program 

Step: run one 
statement 

Step Over: 
run one 
statement, 
but step 
over a CALL 

Step Return: 
run until 
return from 
subprogram 

Disconnect: 
from the 
debug engine 

Animated Step: 
Steps into the 
program 
automatically at a 
rate you specify 

Notice the icons in the debug view. Click them to make the program take certain actions. 

The green triangle is resume. It causes the program to run until it encounters a 
breakpoint. If no breakpoints are set, or if the program does not reach a breakpoints as it 
runs, it runs all the way to the termination of the application. 

The red box is terminate. It forces the immediate termination of the application with a 
zero return code. If you click it, no more statements will run. 

The disconnect icon disconnects the debugger from the application, but allows the 
application to continue running. 

The yellow down arrow is “step”, or “step into”, which runs a single program statement. 
You can watch a program run statement by statement by clicking the step icon repeatedly. 
If the current statement calls a sub-program, in many cases it will step directly into the 
subroutine or procedure. 

The step over icon allows you to step over a sub-program. Use this when you are on a 
statement that calls a sub-program, and you want the subroutine to run, but do want to 
see it in the debugger. 

The step return button is used to run until the next program return. Use it to easily run to 
the end of a program or sub-program and then stop. 
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Right click to open menu 
driven breakpoint building

    
  

               
           

               
   

The Breakpoints view 

Breakpoints view description 
� Lists breakpoints 

� Set address, entry, statement, load, and watch breakpoints 

� Delete breakpoints 

� Enable and disable breakpoints 

-Right-click to open menu 
driven breakpoint building 
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The breakpoints view displays a list of breakpoints that have been set. With pop-up menu 
options, you can add, change, and remove breakpoints, and enable or disable 
breakpoints. You will see more about the different types of breakpoints, and how to set 
breakpoints in a minute. 
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The Variables view 

Variables view description 
� Displays variables associated with the stack frame selected in 

the debug view 
� Monitor local variables and memory 
� Change representation (hex, decimal) 
� Filter locals (all, current, previous, language based criteria) 

IBM Debug Tool for z/OS tutorial 33 © 2012 IBM Corporation 

The variables view is a place where you can see and change the values of variables in 
your program. You can display the auto monitor, which is a dynamic display that shows 
which ever variables are referenced by the current statement. Or you can display all local 
variables in the program, or optionally for COBOL programs, you can display all variables 
in the working-storage, linkage, or file section. 
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The Monitors view 

Monitors view description 
� Shows variables and expressions that you have selected 
� Add or remove a variable or expression to the monitor 
� Change representation (hex, decimal) 
� Change a variable value 

IBM Debug Tool for z/OS tutorial 34 © 2012 IBM Corporation 

The monitors view is another place where you can display and change variables. Having 
two views to display variables, the monitors and the variables view, gives you a lot of 
flexibility, and makes it easy to always see the variables you need. You can add as many 
individual variables as you need to the monitor, and remove them individually when you do 
not need to see them any more. You can optionally auto monitor variables in the monitor, 
so you always automatically see referenced variables as you step through a program. 
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The Registers view 

Registers view description 
� Lists register values 
� Change a register value 
� Add a register group 

IBM Debug Tool for z/OS tutorial 35 © 2012 IBM Corporation 

The registers view lets you view and change the contents of machine registers. The 
different sets of registers can be seen, including the general purpose, 64-bit general 
purpose, floating point registers, and others. 
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The Memory view 

Memory view description 

�View and modify memory 

�Add / remove memory monitor 

�Contains two panes -- the Memory Monitors pane and the 
Memory Renderings pane 
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The memory view is used to display and change the contents of memory. You can see 
memory at the address of a variable, based on a register, or at an address you specify. 
There are several rendering formats available, including hexadecimal, EBCDIC, ASCII, 
signed integer, and unsigned integer. 
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The Modules view 

Modules view description 
� Displays a list of modules loaded while running your application 
� Expand items to see compile units, files, and functions 
� Double-click source file nodes to open source in the editor 

IBM Debug Tool for z/OS tutorial 37 © 2012 IBM Corporation 

The modules view displays information about program modules. A module can be 
expanded to show compile units, related debug files, and functions. When debugging an 
application with multiple modules, you can double-click a debug file to have the program 
displayed in the source window. This gives you an easy way to see the source of a 
program other than the program currently running. For example, if currently running in a 
sub-program, you can refer to the source of the main program. 
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The Debug Console 

Debug Console description 

� Issue commands to the debug engine 

� View messages from the engine and commands 
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The Debug Console allows you to issue commands to the debugging engine, which is 
controlling the program that is running on the host system. The commands available here 
are a subset of the commands available in the 3270 terminal debugging interface, and 
include commands to take actions such as turn the auto monitor on or off, load debugging 
source files, change settings, and many others. 

That is the end of this section. Please continue with the next section, using the GUI 
debugger. 
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Feedback 

Your feedback is valuable 

You can help improve the quality of IBM Education Assistant content to better 
meet your needs by providing feedback. 

� Did you find this module useful? 

� Did it help you solve a problem or answer a question? 

� Do you have suggestions for improvements? 

Click to send email feedback: 

mailto:iea@us.ibm.com?subject=Feedback_about_DTv12s17GUIIntroductionAndViews.ppt 

This module is also available in PDF format at: ../DTv12s17GUIIntroductionAndViews.pdf 
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You can help improve the quality of IBM Education Assistant content by providing 
feedback. 
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